SAS® Theme Designer 3.3: User’s Guide
Contents

SAS Theme Designer 3.3 Audience ................................................................. v
What’s New in SAS Theme Designer 3.3 ...................................................... vii

Chapter 1 • Getting Started ........................................................................ 1
About SAS Theme Designer ........................................................................... 1
Prerequisites for Accessing SAS Theme Designer 3.3 ................................ 1
Accessing SAS Theme Designer .................................................................... 2
Working in SAS Theme Designer ................................................................... 2
SAS Application Themes .................................................................................. 3
SAS Report Themes ........................................................................................ 4
Using SAS Themes in SAS Viya Products ....................................................... 4
SAS Help Center .............................................................................................. 5

Chapter 2 • Creating and Working with SAS Themes .................................. 7
SAS Themes ..................................................................................................... 7
Creating a New Application Theme ................................................................ 7
Creating a New Report Theme ........................................................................ 12
Previewing Changes to a Theme ...................................................................... 16
Changing Palette Colors .................................................................................. 16
Interface Styles ............................................................................................... 18
Page Styles ....................................................................................................... 24
Graph Styles ..................................................................................................... 27
Editing an Application Theme in Context ...................................................... 29
Saving a Theme ............................................................................................... 33

Chapter 3 • Managing SAS Themes ............................................................. 35
Theme Table Overview .................................................................................... 35
Sorting on Columns .......................................................................................... 38
Working with Themes Provided by SAS ......................................................... 38
Working with Retired Themes ......................................................................... 39
Working with Hidden Themes ......................................................................... 40
Exporting and Importing a SAS Theme ........................................................ 40
Publishing Themes .......................................................................................... 41
Setting a Default Theme .................................................................................. 42
Theme Designer Settings ................................................................................ 42
SAS Help Center .............................................................................................. 43
Assigning Users to Custom Groups ............................................................... 43

Chapter 4 • Examples .................................................................................... 45
Creating an Application Theme ....................................................................... 45
Creating a Report Theme ................................................................................. 51
Editing a Theme in Context ............................................................................ 58

Chapter 5 • Troubleshooting SAS Theme Designer ..................................... 65
Troubleshooting Mozilla Firefox Time Threshold ......................................... 65

Recommended Reading .................................................................................. 67
Glossary ........................................................................................................... 69
SAS Theme Designer 3.3

Audience

The intended audience for SAS Theme Designer 3.3 includes administrators who develop and maintain SAS themes as well as individual users who access SAS themes from within different SAS Viya applications.
What’s New in SAS Theme Designer 3.3

The following items are new for SAS Theme Designer 3.3:

• The predefined report themes Midnight and Opal are available with SAS Theme Designer 3.3. See “Working with Themes Provided by SAS” on page 38.

• Some report themes that were available in SAS Theme Designer 4.7.3 for Flex are available for use as retired report themes in SAS Theme Designer 3.3. See “Working with Retired Themes” on page 39.

• After you have published a theme in SAS Theme Designer 3.3, you can choose to hide a theme from view in SAS Viya applications. See “Working with Hidden Themes” on page 40.
What's New in SAS Theme Designer 3.3
Chapter 1
Getting Started

About SAS Theme Designer
SAS Theme Designer 3.3 enables you to easily customize the appearance of various SAS Viya applications. A SAS theme defines the overall look and feel of an application or a report. It is designed using colors and graphics that are applied to common user interface components and layout containers. A well-designed theme can create a strong visual identity across a product or set of products. You can use SAS Theme Designer to create and deploy simple, visually appealing, customized themes.

Prerequisites for Accessing SAS Theme Designer 3.3
In order to access SAS Theme Designer 3.3, you must be included in the Application Administrators group. See “Assigning Users to Custom Groups” on page 43 for more information.
Accessing SAS Theme Designer

The applications menu enables you to easily select SAS Viya applications that you have access to. The applications menu is available in the upper left corner of your SAS Viya application window. Select ▾ to expand the listing of available SAS Viya applications. From here you can select Administration ➔ Manage Themes to open the SAS Theme Designer application:

Here is the applications menu expanded

Note: The list of SAS Viya products that are shown in the applications menu is based on your individual installation and user access.

To exit the current session of SAS Theme Designer, click on the current user icon in the upper right corner of the SAS Theme Designer window. The Application Options menu is displayed. From here you can select Sign out.

Working in SAS Theme Designer

Once you sign in to SAS Theme Designer, you can create new themes and modify existing themes. Below is the main window for SAS Theme Designer 3.3.
Here are the tasks that you can perform from this window:

Table 1.1 Theme Designer Tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an existing theme</td>
<td>You can select an existing theme from the table of available themes in order to perform different administrative tasks. Some of the tasks that you can perform include renaming, deleting, duplicating, and exporting themes.</td>
</tr>
<tr>
<td>Create a new theme</td>
<td>You can create a new custom application theme or a new custom report theme.</td>
</tr>
<tr>
<td>Import a theme</td>
<td>You can import a theme from a specific folder to SAS Theme Designer 3.3.</td>
</tr>
<tr>
<td>Access other SAS products from the applications menu.</td>
<td>By selecting ☰, you can access various SAS Viya products including SAS Drive and SAS Visual Analytics 8.4.</td>
</tr>
<tr>
<td>Access the Help Center</td>
<td>You can access the Help Center by selecting Applications Option and Help Center. The Help Center contains documentation for SAS Theme Designer 3.3.</td>
</tr>
</tbody>
</table>

SAS Application Themes

SAS Theme Designer enables you to apply your own branding and customization to make SAS Viya applications conform with the rest of your software environment. SAS recognizes that users at your site often use more than one SAS application in their daily work. Having a consistent look and feel ensures that the user’s transition from one application to the next is as seamless as possible.
SAS Theme Designer provides predefined application themes. Here are the application themes provided by SAS:

High Contrast
This theme presents a dark background with high-contrast foreground elements to meet the needs of users with low vision.

Illuminate
This theme presents a clean and uncomplicated color palette that is easy to use. The Illuminate theme is the default application theme.

Inspire
This theme presents vibrant and cohesive colors that shift the emphasis from the application to the content.

For more information about creating custom application themes see “Creating a New Application Theme” on page 7.

SAS Report Themes

The second type of theme that you can create in SAS Theme Designer is a report theme. You can create report themes that can be used in SAS Visual Analytics 8.4 reports. A report theme contains settings that control the color selections for different elements of a report such as tables, graphs, and controls.

SAS Theme Designer provides predefined report themes. Here are the report themes provided by SAS:

High Contrast
This theme presents a dark background with high-contrast foreground elements to meet the needs of users with low vision.

Aqua
Presents a white background with a vibrant color palette and subtle gradient on graphical elements.

Marine
This theme presents a white background with vivid colors and a subtle gradient on graphical elements. The Marine theme is the default report theme.

Midnight
This theme presents a dark blue background with a bright color palette and strong outlines that make the graphical elements glow.

Opal
This theme presents a white background with a bright color palette.

For more information about creating custom report themes see “Creating a New Report Theme” on page 12.

Using SAS Themes in SAS Viya Products

Application themes that are created in SAS Theme Designer 3.3 can be used and further modified in SAS Viya products that are accessible on the web such as SAS Visual Analytics and SAS Drive. You can also preview edits to SAS application themes while accessing other SAS Viya products. Editing in context enables you to preview edits to an
application theme from another SAS Viya application. You can perform the following tasks from the Edit In Context pane:

- edit Interface Styles and Graph Styles color settings for an application theme
- save a theme
- save and publish an application theme
- save a copy of a theme
- switch to a different SAS Viya product to edit the theme.

Because a SAS application theme applies to the overall SAS Viya environment, when editing in context you can preview the application theme in any available SAS Viya products.

For more information see “Editing an Application Theme in Context ” on page 29.

---

SAS Help Center

You can access the SAS Theme Designer 3.3 User’s Guide while in SAS Theme Designer by opening the Help Center. To access the Help Center click on the current user icon in the upper right corner of the SAS Theme Designer window. The Application Options menu is displayed. From here you can select Help Center. The SAS Theme Designer 3.3 User’s Guide is available from the Help Center in HTML format and PDF.

Note: Pop-up blockers for your browser should be disabled in order to display the Help Center.
Chapter 2
Creating and Working with SAS Themes

SAS Themes
Creating a New Application Theme
Creating a New Report Theme
Previewing Changes to a Theme
Changing Palette Colors
Interface Styles
Page Styles
Graph Styles
Editing an Application Theme in Context
Saving a Theme

SAS Themes
A SAS application theme enables you to create a consistent look and feel that can be applied to multiple SAS applications in your SAS Viya environment. You can apply custom colors to different elements of your SAS Viya environment, including primary elements, messages, tables, and graphs.

A SAS report theme applies a consistent look and feel to SAS report content. SAS report themes are customized for reports that are created in SAS Visual Analytics. You can apply custom colors to different elements of your SAS report theme, including tables, graphs, and controls.

Creating a New Application Theme
You can create a new application theme in SAS Theme Designer 3.3 by following these steps:

1. On the Theme Designer window, select New. From the menu that opens, select one of the available base application themes from which you can create a new theme:
   • Illuminate
• Inspire

Or, you can create a new theme by selecting **Starter Palettes ⇒ New Application Theme**. The **Starter Palettes** pane enables you to create a new theme that is based on a preselected set of theme colors.

A **New Application Theme** window appears. You can now begin making changes to the new theme. The **Preview** pane contains sample items that display the changes that you make to the theme.

Here is the **New Application Theme** window:

The theme name is displayed above the **Preview** pane. For application themes, the default name is **New Application Theme 1**. You can change the default name for a theme by clicking the default name and entering a new name.

2. You can now make changes to different color palette swatches for the theme, including changes for **Interface Styles** and **Graph Styles**.

3. The SAS Theme Designer **Preview** pane displays the theme as you modify it. It enables you to easily see changes that take place when theme properties are modified. When the **Live preview** option is selected, you can see changes in the **Preview** pane in real time as the changes are being made. If you clear the **Live preview** option, you must click **Refresh** (_refresh) to see changes.
You can also step back through changes with the **Undo** or **Redo** function.

4. It is also possible to see the changes that you are making to a theme while in a different SAS Viya application. In-context editing provides a live preview of theme changes within the application that you choose. As you change theme properties, the application's appearance reflects these changes.

When you choose **Edit in Context**, you temporarily move to an application of your choice. Theme options are displayed in a floating pane. Your changes are applied directly to the application. This enables you to see what a SAS application will look like when your theme is used.

Click the **Edit in Context** button on the Theme Designer window. The **Edit in Context** pane opens.

On the **Edit in Context** pane, select the SAS Viya application that you want to view. In this example, **SAS Drive** is selected.

Now click the **Edit in Context** button on the **Edit in Context** pane. SAS Drive opens.
5. The **Edit Theme** pane is now available from within SAS Drive.

You can make changes to interface styles and graph styles for the theme and view the changes as you make them. Here is the **Edit Theme** pane with **Interface Styles** selected.
6. After you have modified your theme, you can save the theme. Click on the Edit Theme pane to open the options menu.

   Select **Save**.

   You can also return to SAS Theme Designer where you can continue to make changes to your theme. To do so, select **Edit in SAS Theme Designer** from the options menu.

   When you return to the application theme window in SAS Theme Designer, you can continue to make changes to your theme.

7. After you have finished modifying the theme, you can save the theme as a draft. You can also save and publish the theme by selecting the appropriate action in the **Save** menu.

   Your new theme is now listed in the table of available themes. Select to return to the main Theme Designer window. You can now use it with other SAS Viya products that consume SAS themes, such as SAS Visual Analytics. A theme must be published in order for all users to access it with other SAS Viya applications.
The Illuminate theme is the default application theme that is provided with SAS Theme Designer 3.3.

**TIP** The default theme can be set by any member of the Application Administrators group.

### Creating a New Report Theme

You can create a new report theme in SAS Theme Designer 3.3 by following these steps:

1. On the SAS Theme Designer window, select **New**. From the menu that opens, select one of the available base report themes from which you can create a new theme:
   - Aqua
   - Marine
   - Midnight
   - Opal

2. You can also create a new theme by selecting **Starter Palettes ⇒ New Report Theme**. The **Starter Palettes** pane enables you to create a new theme that is based on a preselected set of theme colors.

   When you select a starter palette in order to create a report theme, the report theme that is created is based on the Marine theme by default.

   ![SAS Theme Designer - Manage Themes](image)

   A **New Report Theme** window appears. The theme name is displayed above the **Preview** pane. For report themes, the default name is New Report Theme 1. You can change the default name for a theme by clicking the default name and entering a new name.
2. From the **Preview** pane, you can click **Choose Report**. A file selection window appears and you can select a report. In this example, the report **Warranty Analysis** is selected.

3. The SAS Theme Designer **Preview** pane displays the report, enabling you to easily see theme property changes as you make them. In this example, a warranty analysis report is displayed.
If the report that you load has multiple tabs, the **List of tabs** button is available. In this report, you can scroll through the tabs that are displayed or you can select from a list of tabs. Click **List of tabs** in the **Preview** pane. A list of the available tabs in the report is displayed. You can select a tab and the Preview pane scrolls to the selected tab.

You can also maximize the view of a single graph or table in the **Preview** pane by selecting ✽. The following image shows the maximized display of a bar chart:
The SAS Theme Designer Preview pane displays the theme as you modify it. It enables you to easily see changes that take place when theme properties are modified. When the Live preview option is selected, you can see changes in the Preview pane in real time as the changes are being made. If you clear the Live preview option, you must click to see changes.

4. Once a report is loaded, you can make changes to different color palette swatches for the report theme. You can now make changes for Page Styles and Graph Styles. Changes to Graph Styles color swatches impact the colors of the different graphs in a report. On the Graph Styles pane, the first default Data palette color is teal.

Note: The first color is used if a single group is displayed in the graph. As more groups are added, the colors are added to each additional group from left to right.

In the following image, the first default Data palette color is changed to purple. The color change is updated in the Preview pane.

5. After you have modified the report theme, you can save the theme as a draft. You can also save and publish the theme by selecting the appropriate action from the Save menu.

A report theme must be published in order for it to work with SAS reports.
The Marine theme is the default report theme that is provided with SAS Theme Designer 3.3.

**TIP**  The default theme can be set by any member of the Application Administrators group.

---

### Previewing Changes to a Theme

After you create or select a theme to work with, you can make changes to the theme and view those changes from the **Preview** pane. The preview pane displays various components that reflect the changes that will be applied to a SAS Viya application or report.

You have two ways to update the **Preview** pane:

- **Live Preview**
  - when this check box is selected, the changes that you make to the theme are automatically updated in the **Preview** pane, as they are made.
  
  *Note:* *Live Preview* is the default setting.

- **Refresh**
  - when **Live Preview** is not selected, clicking updates the **Preview** pane. You must click in order to see your theme changes. When you click , a loading indicator is displayed until the update is complete.
  
  *Note:* The button is enabled only if the **Live Preview** option is not selected.

---

### Changing Palette Colors

You can modify various color settings for a theme by changing individual color palette swatches. When changing the color for a palette swatch, you can choose from **Basic** or **Custom** color changes.

- **Basic**
  - The **Basic** tab displays a listing of **Standard colors** to choose from. Listings of **Recent custom colors** and **Recent standard colors** are also displayed.
When you select a standard color, it is added to the list of **Recent standard colors**.

**Custom**

The **Custom** tab displays a custom palette that enables you to select a custom color. The **Current color** and **New color** swatches are displayed. Decimal values for **Red**, **Green**, **Blue**, and **Hex Value** are also displayed.

Click on the area of the palette that you want to select a color from. The values for the color are then displayed. You can also click and drag the pointer to move over the palette. The **New color** swatch is updated to the selected color. You can also adjust the vertical slider control to change the colors displayed on the palette. Another option is to enter the values for the red, green, and blue decimal values, or to enter the hexadecimal value of the color. When you have identified a color that you want, click **OK** to accept the color values.
When you select a custom color, it is added to the list of Recent custom colors that is available on the Basic tab.

Interface Styles

You can change color settings for various components of an application theme on the Interface Styles pane. You can change Global color settings for a theme and specify Overrides for those color settings.
The **Global** tab provides color settings for **Branding** and **Messages** color settings. You can also specify a **Base font** for styles.

Here is the **Interface Styles** pane with the **Global** tab displayed:

![Interface Styles Pane]

The **Branding** color settings include the following options:

**Table 2.1  Branding Color Settings**

<table>
<thead>
<tr>
<th>Branding Color Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Primary</strong></td>
</tr>
<tr>
<td>The primary color sets the tone for an application, and appears most prominently in the banner and side menu</td>
</tr>
<tr>
<td><strong>Tip:</strong> Use the primary color to introduce your primary brand color into the user interface.</td>
</tr>
<tr>
<td><strong>Secondary</strong></td>
</tr>
<tr>
<td>The secondary color is used to highlight certain elements within the content area. This color can indicate whether items are active or selected. Some elements that use the secondary color include: selected check boxes or radio buttons, selected day in a calendar, and selected stars in a rating.</td>
</tr>
<tr>
<td><strong>Neutral</strong></td>
</tr>
<tr>
<td>The neutral color is a mid-tone that is applied to interface elements. The neutral color should support the primary content of the page without distraction. For example, some theme elements are best read in a neutral color. Elements that use neutral colors include: page backgrounds, element backgrounds, borders, body text, links, tab tiles, table header text, deselected menu items, deselected icons, normal buttons, and helper text.</td>
</tr>
<tr>
<td><strong>Tip:</strong> Although it is possible to set the neutral color to any color, you should use a dark tone for light themes and white or a light tone for dark themes.</td>
</tr>
</tbody>
</table>
Branding Color Settings

Base font
Select the desired font and font size for the theme.

The Messages color settings include color options for different types of text in a theme. This includes the following text elements:

Table 2.2  Messages Color Settings

<table>
<thead>
<tr>
<th>Messages Color Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Information</strong>: the selected color is applied to basic information.</td>
</tr>
<tr>
<td><strong>Success</strong>: the selected color is applied to success messages.</td>
</tr>
<tr>
<td><strong>Warning</strong>: the selected color is applied to warning messages.</td>
</tr>
<tr>
<td><strong>Alert</strong>: the selected color is applied to alert messages.</td>
</tr>
</tbody>
</table>

The Overrides tab contains advanced style color overrides. Overrides settings apply to any part of an application to which the theme is applied.

Here is the Interface Styles pane with the Overrides tab displayed:

<table>
<thead>
<tr>
<th>Interface Styles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
</tr>
<tr>
<td>&gt; Banner</td>
</tr>
<tr>
<td>&gt; Initial Loading Screen</td>
</tr>
<tr>
<td>&gt; Transition Screen</td>
</tr>
<tr>
<td>&gt; Crosstab</td>
</tr>
<tr>
<td>&gt; Tables</td>
</tr>
</tbody>
</table>

The following Banner color override settings are used to modify banner colors:

Table 2.3  Banner Override Settings

<table>
<thead>
<tr>
<th>Banner Override Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background</td>
</tr>
<tr>
<td>Text</td>
</tr>
</tbody>
</table>
Banner Override Settings

**Logo** - In the logo box, select a file to display as the logo image. You can drag and drop an image to the logo box or you can browse the file system and select an image file.

*Important:* Image files that you add to a theme must each be 3 MB or less.

The following **Initial Loading Screen** override settings are used to modify the **Initial Loading Screen** image on the **Animations** view in the **Preview** pane:

*Table 2.4 Initial Loading Screen Override Settings*

<table>
<thead>
<tr>
<th>Initial Loading Screen Override Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Background</td>
</tr>
<tr>
<td>Radial gradient</td>
</tr>
<tr>
<td><strong>Loading animation</strong> - Select a file to display as the loading screen animation. You can use the default animation or you can browse the file system and select a custom animation or a static image.</td>
</tr>
<tr>
<td><em>Important:</em> Image files that you add to a theme must each be 3 MB or less.</td>
</tr>
<tr>
<td>Animation</td>
</tr>
</tbody>
</table>

The following **Transition Screen** override settings are used to modify the **Transition Screen** image on the **Animations** view in the **Preview** pane:

*Table 2.5 Transition Screen Override Settings*

<table>
<thead>
<tr>
<th>Transition Screen Override Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Background</td>
</tr>
<tr>
<td><strong>Loading animation</strong> - Select a file to display as the transition screen animation. You can use the default animation or you can browse the file system and select a custom animation or static image.</td>
</tr>
<tr>
<td><em>Important:</em> Image files that you add to a theme must each be 3 MB or less.</td>
</tr>
<tr>
<td>Animation</td>
</tr>
</tbody>
</table>

The following **Crosstab** color override settings are used to modify **Crosstab** colors in the **Preview** pane:

*Table 2.6 Crosstab Override Settings*

<table>
<thead>
<tr>
<th>Crosstab Override Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outer border</td>
</tr>
<tr>
<td>Inner borders</td>
</tr>
</tbody>
</table>
### Crosstab Override Settings

<table>
<thead>
<tr>
<th>Column Headers</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Background</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Row Headers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
</tr>
<tr>
<td>Background</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Measure Headers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
</tr>
<tr>
<td>Background</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
</tr>
<tr>
<td>Row background</td>
</tr>
<tr>
<td>Alternating row background</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Totals text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals background</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Subtotals text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subtotals background</td>
</tr>
</tbody>
</table>

The following **Tables** color override settings are used to modify **Table** colors in the **Preview** pane:

**Table 2.7  Tables Override Settings**

<table>
<thead>
<tr>
<th>Tables Override Settings</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Outer border</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Headers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
</tr>
<tr>
<td>Background</td>
</tr>
<tr>
<td>Borders</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
</tr>
<tr>
<td>Row background</td>
</tr>
<tr>
<td>Alternating row background</td>
</tr>
<tr>
<td>Borders</td>
</tr>
</tbody>
</table>

22 Chapter 2 • Creating and Working with SAS Themes
Tables Override Settings

Totals text

Totals background

The Preview pane contains sample items that display the Interface Style changes. You can toggle between Table, Messages, or Animations view on the left side of the Preview pane.

You can also toggle between different Pane views on the right side of the Preview pane.

You can unpin the Preview pane. Select Unpin the pane. You can then select Pin the pane.

**TIP** You can toggle between Interface Styles and Graph Styles on the Property pane. You can select Hide pane to close both settings.

**Note:** The default message that is displayed on the Global and Overrides tabs can be removed. Beside the default message, select X. The message is removed. You can reinstate the message by selecting Reset Messages on the Settings ⇒ Global ⇒ General settings pane. See “Theme Designer Settings” on page 42 for additional details.
Page Styles

When you are working with a report theme, you can change basic color settings for different components of a report theme on the Page Styles pane. You can change Global color settings for a theme and specify Overrides for those color settings.

Here is the Page Styles pane with the Global tab displayed:

![Page Styles pane]

The Global tab enables you to select a base report theme in order to apply its settings to the current report theme. From the Base theme drop-down menu, you can select one of the base report themes. The Preview pane is updated with the selected base theme settings. If you make changes to color swatches, you can revert to the base theme colors by selecting the Reset to base theme defaults option.

The Global tab provides color settings for Branding color settings. You can also specify a Base font for styles.

The Global color settings include the following options:

<table>
<thead>
<tr>
<th>Table 2.8 Global Color Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Global Color Settings</strong></td>
</tr>
<tr>
<td><strong>Primary:</strong></td>
</tr>
<tr>
<td>The primary color sets the tone for a report, and appears most prominently in the banner and side menu.</td>
</tr>
<tr>
<td><strong>Note:</strong> The primary color is used for application themes. With the exception of the Midnight theme, the primary color is not used in report themes.</td>
</tr>
<tr>
<td><strong>Tip:</strong> Use the primary color to introduce your primary brand color into the user interface.</td>
</tr>
</tbody>
</table>
Global Color Settings

Secondary:
The secondary color is used to highlight certain elements within the content area. This color can indicate whether items are active or selected. Some elements that use the secondary color include: selected check boxes or radio buttons, selected day in a calendar, and selected stars in a rating.

Neutral
The neutral color is a mid-tone that is applied to report elements. The neutral color should support the primary content of the report without distraction.

Tip: Although it is possible to set the neutral color to any color, you should use a dark tone for light themes and white or a light tone for dark themes.

Important: The Midnight theme currently uses white as the neutral color.

Base font
Select the desired font and font size for the theme.

Tip When you are customizing a report theme, it is a good practice to ensure that the report controls (button bars, drop-down lists, and so on) are displayed consistently in that report theme. You can customize report controls by selecting new colors for Secondary and Neutral colors on the Global tab.

The Overrides tab contains advanced style color overrides.

Table 2.9 Crosstab Override Settings

Crosstab Override Settings

Outer border

Inner borders

Column Headers
• Text
• Background
The following Tables color override settings are used to modify Table colors in the Preview pane:

**Table 2.10  Tables Override Settings**

<table>
<thead>
<tr>
<th>Tables Override Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outer border</td>
</tr>
<tr>
<td>Headers</td>
</tr>
<tr>
<td>• Text</td>
</tr>
<tr>
<td>• Background</td>
</tr>
<tr>
<td>• Borders</td>
</tr>
<tr>
<td>Cells</td>
</tr>
<tr>
<td>• Text</td>
</tr>
<tr>
<td>• Row background</td>
</tr>
<tr>
<td>• Alternating row background</td>
</tr>
<tr>
<td>Totals text</td>
</tr>
<tr>
<td>Totals background</td>
</tr>
<tr>
<td>Subtotals text</td>
</tr>
<tr>
<td>Subtotals background</td>
</tr>
</tbody>
</table>
From the **Preview** pane, you can click **Choose Report**. A file selection window appears and you can select a report. Depending on the SAS report that you have loaded with **Choose Report**, different elements (that are relevant to the current report) are displayed in the **Preview** pane.

Once a report is loaded, you can now make changes to different color palette swatches and see them applied to the report.

**TIP** You can toggle between **Page Styles** and **Graph Styles** on the **Property** pane. You can select **Hide pane** to close both settings.

**Note:** The default message that is displayed on the **Global** and **Overrides** tabs, can be removed. Beside the default message, select **×**. The message is removed. You can also reinstate the message by selecting **Reset Messages** on the **General** settings pane. See “Theme Designer Settings” on page 42 for additional details.

---

**Graph Styles**

Graph styles enable you to change color settings for graphs in SAS Viya applications or for SAS reports. The colors in the **Preview** pane are controlled by the color swatches in the **Graph Styles** pane. Depending on if you are changing an application theme or a report theme, changes to color swatches are displayed in different components of the **Preview** pane. The following image shows a sample bar chart for an application theme.

The **Graph Styles** pane contains color settings for the following items:

**Global Data Colors**

In application themes, these colors are used for **Solid Data Colors**, **Gradient Data Colors**, and for **Gauges** that are displayed in the **Preview** pane. For report themes, the graphs and charts that are part of the report display color changes. You can change graph colors for the following items:

**Data Palette**

These color swatches are for charts and graphs. You can change a color swatch by clicking on the swatch and selecting a new color from a set of standard colors or from a color palette. You can change the order of display for the different colors on the **Data palette** by using the **Reorder** button.

Below is the **Graph Styles** pane with the **Reorder** button selected:
Swatches can be moved on the **Data palette**. You can click and drag a color to rearrange the order of colors.

In the following image, the teal color swatch was moved to the bottom of the **Data palette**. The **Preview** pane shows the order of colors that you have chosen.
When you are finished reordering color swatches, click **Reorder** to close the function.

For further formation about the use of the keyboard to reorder color swatches see “Reorder Color Swatch Shortcuts” in *SAS Theme Designer: Accessibility Features*.

**Gauge Palette**

These colors are used to customize the look of gauges and other graph elements in a SAS Viya application. These colors are used in gauges, increasing and decreasing values in the waterfall chart, and gradients that show KPI colors. They are displayed on the **Preview** pane.

---

**Editing an Application Theme in Context**

In-context editing enables you to see a live preview of theme changes in the application of your choice. The view of the application updates to show your theme changes as you make them. **Edit in Context** is available for use with application themes. It is not available for use with report themes.

On the SAS Theme Designer window, click **Edit in Context**. The **Edit in Context** pane opens.

From here, you can choose another SAS Viya application to go to.
Then, click **Edit in Context**. The SAS Viya application that you selected opens.

You can continue making changes to your theme on the **Edit Theme** pane that opens in the designated SAS Viya application. The **Edit Theme** pane is opened in a fixed location of the SAS Viya application that you selected and cannot be moved.

From here, you can edit **Interface Styles**.
You can also edit **Graph Styles**.
To save the theme or modify where you are working on the theme, click the menu of available actions.

The Edit Theme menu contains the following items:

Save
enables you to save the theme that you are currently editing.

Save and publish
enables you to save and subsequently publish the theme that you are currently editing.

Save a copy
enables you to save a copy of the theme that you are currently editing.

Change edit context
enables you to change the SAS Viya application that you are currently editing the theme in.

Edit in SAS Theme Designer
switches to the Edit Theme pane in the SAS Theme Designer application.

Tip: If you click the in the upper right corner of the Edit Theme window, then Edit in Context closes and SAS Theme Designer opens. Changes made while in Edit in Context are maintained and displayed in SAS Theme Designer.

Tip: While the Edit Theme pane is open, you cannot navigate to other SAS Viya applications from the applications menu. If you click the applications menu, a message is displayed, instructing you to use the Edit Theme pane to choose a different application or return to SAS Theme Designer.
Saving a Theme

When you are finished editing a theme, you can save the theme by selecting Save or Save and Publish from the drop-down menu.

Publishing a theme makes the theme available for other users to select. When a theme has not been published, both of the options Save and Save and Publish are available. If you select Save and Publish from the drop-down menu, the theme is published for use in SAS Viya applications. When a theme has been published and is being edited, only Save and Publish is available.

After you have finished making changes to a theme, you can return to the main SAS Theme Designer window by selecting View All Items. This option is located above the Preview pane.
Chapter 3
Managing SAS Themes

Theme Table Overview

After you have created and published a SAS theme, it is available for use in various SAS Viya applications or reports. Available SAS themes are listed in the theme table. This includes system themes provided by SAS, custom created themes, and retired themes.

From here you can select a custom theme to open and edit. You can also publish, unpublish, duplicate, rename, export, and delete a theme. You can also designate a theme to be hidden in the user interface. A selection check box is available next to each theme. When a theme is selected, actions that can be performed on the selected theme or themes are displayed. The action icons are not enabled until one or more relevant themes is selected.

Here is the theme table.
The theme table contains the following columns:

- **Theme** displays the name of a theme and the color palette.
- **Type** displays whether a theme is an application theme or a report theme.
- **Status** lists the status of a theme. A theme is either in a Draft state or is Published.
- **Date Modified** displays a relative time that a theme was last edited.
- **Default** indicates which themes are default themes. SAS Theme Designer provides a default application theme called Illuminate and a default report theme called Marine. Only one default theme can be set for each type (application and report).
- **Hidden** indicates which themes are hidden. Hidden themes are not shown in the user interface, but continue to be used wherever they were previously selected until a different theme is chosen.

**Filter** enables you to search and filter the list of available themes that are listed in the Theme table.

The actions that you can perform are located in the upper right corner of the SAS Theme Designer window. Actions are enabled for a theme depending on the status of the theme and whether it is a theme provided by SAS or a custom theme. The action buttons are not enabled until one or more relevant themes is selected.

Here are the actions that you can perform with a theme:

**Publish** enables you to publish a theme so that other SAS Viya users can access the theme. The **Status** column lists themes as either Draft or Published. The **Publish** function is applicable only to themes that are in draft mode. Select a draft theme and click **Publish**. The theme is now published.

**Unpublish** enables you to unpublish a theme. A theme is unpublished in order to make it unavailable to SAS Viya applications. Select a published theme and click **Unpublish**. The theme is now unpublished.
Note: The themes provided by SAS cannot be unpublished. They include Illuminate, Inspire, Aqua, Marine, Midnight, Opal, and High Contrast (for both application and report).

**Duplicate** enables you to make a duplicate copy of a theme. Select a theme and click . In the window that opens, you can choose to copy the theme as an application theme or a report theme.

In the **Name** field, enter a name for the new theme. From the **Type** menu, select either **Application Theme** or **Report Theme**. Click **Save**. The new theme is created.

**Rename** enables you to rename a theme. Select a theme and click . The **Rename** pane opens. Enter a new name for the theme and click **OK**.

Note: The application and report themes that are provided by SAS cannot be renamed. They include Illuminate, Inspire, Aqua, Marine, Midnight, Opal, and High Contrast.

**Set Default** enables you to select a published theme as the default theme. **Illuminate** is the default application theme and **Marine** is the default report theme.

Select a theme and click . This theme is now the default theme.

**Show in user interface** enables a published theme to be visible. By default, published themes are shown in the user interface wherever themes can be chosen.

**Hide from user interface** enables you to hide a published theme from view in the user interface. Hidden themes are not shown in the user interface, but continue to be used wherever they were previously selected until a different theme is chosen.

**Export** enables you to export themes from SAS Theme Designer to a file on the browser file system. Select one or more themes and click . The themes are automatically exported to a file in a specified folder on your file system. See “Exporting and Importing a SAS Theme” on page 40 for more information.
Delete enables you to delete a theme. Select a theme and click Delete. The Delete pane appears. Confirm the deletion by clicking Delete.

*Note:* The themes provided by SAS cannot be deleted. These themes include Illuminate, Inspire, Aqua, Marine, Midnight, Opal, and High Contrast (for both application and report).

---

### Sorting on Columns

You can sort the different columns in the theme table. To change the sort order, you can click on a column heading and the default ascending sort is made. You can also right-click on a column heading and select Sort. A sort menu is displayed. You can select from the following available sort options:

- **Sort (ascending)**
- **Sort (descending)**
- **Remove sort**. This option removes the sort option that is applied to the selected column.

Here is a figure of the Theme Column with the Sort function selected:

![Sort function example](image)

You can also select and sort multiple columns by using Ctrl+Click. If you select additional columns, the sort options **Add to sort (ascending)** and **Add to sort (descending)** are enabled. These functions are initially disabled. These options enable you to add a column to the Sort function.

You can resize the width of a column. Right-click on a column heading and select Resize. The column edge becomes active and you can then drag the column edge to the right or left to change the column width. You can also resize the width of a column by placing the pointer between the columns until the column edge becomes active, and then click and drag to resize.

---

### Working with Themes Provided by SAS

SAS Theme Designer 3.3 provides several predefined application and report themes that each offer a different look and feel. These themes can be set as the default theme or
hidden from the list of themes available to end users. In addition, many of these themes can be used as a basis to create new custom themes.

You can create a custom theme by using the New menu or by clicking on a SAS theme that you would like to use as a base theme in the Themes table.

The application themes provided by SAS that can be used as a base theme include:

- Illuminate
- Inspire

The report themes provided by SAS that can be used as a base theme include:

- Aqua
- Marine
- Midnight
- Opal

You can set one of these themes as a default theme. However, you cannot modify or perform other actions on predefined themes that are provided by SAS.

In addition to these predefined themes, High Contrast application and report themes are available. However, the High Contrast themes cannot currently be used as a basis to create a new theme.

### Working with Retired Themes

SAS Theme Designer 3.3 provides some report themes that were available in SAS Theme Designer 4.7.3 for Flex. These retired report themes are available for use but have some restrictions. In addition, you can use imported custom themes that are based on retired themes. The following retired report themes are available for use in SAS Theme Designer 3.3:

- Dark
- Light
- Snow

*Note:* The report themes Dark, Light, and Snow are hidden by default. See “Working with Hidden Themes” on page 40.

You can use retired themes with reports that you have moved from your SAS Theme Designer 4.7.3 for Flex environment. However, some restrictions apply when working in SAS Theme Designer 3.3:

- Retired themes provided by SAS cannot be used as a base theme.
- Retired themes provided by SAS and custom retired themes that are imported to SAS Theme Designer 3.3 are automatically placed in the published state.
- You cannot edit a retired report theme provided by SAS. If you select a retired theme to edit, you are then prompted to create a new theme from a different base theme. The theme window opens in the edit mode with the selected base theme in place.

*Note:* Reports that use a retired report theme provided by SAS are not updated.

- You cannot edit a custom report theme that is based on a retired theme. You can continue to use these custom report themes in old and new reports if the theme still matches the style that you want. If you want to update the look of reports that use a
custom report theme that is based on a retired theme, you can upgrade the custom theme to be based on a currently supported base theme. Once the upgrade is complete, all reports that use the custom report theme automatically receive the updated look.

To replace a custom report theme that is based on a retired theme, follow these steps:

1. Click on the retired theme in the Themes table
2. In the window that opens, choose a base theme, and then click Edit New Theme and Replace. The theme window is opened. You can then edit the replacement theme.
3. When you are finished editing the replacement theme, click Save and publish. This finishes the process of replacing the retired theme.

Note: If you exit the theme window without saving, your retired theme will not be replaced.

- You cannot edit a custom retired application theme. For custom retired application themes, you can continue to use the custom retired theme in applications. If you attempt to edit the custom retired theme, you are prompted to create a new theme from a different base application theme. The theme is opened in the edit mode with the selected base theme in place. Users that have selected this theme in an application see the new theme automatically.

### Working with Hidden Themes

Published themes are available and shown in SAS applications that use themes (such as SAS Visual Analytics). However, you can choose to hide a theme from view in SAS applications. After you have published a theme in SAS Theme Designer 3.3, you can assign a theme to be hidden.

The Hidden column in the themes table shows which themes are designated as hidden. In the themes table, you can select the check box for a theme that you want to hide and then select ☐. The theme is now hidden from view in SAS applications that use themes. Once a theme is assigned a hidden status, you can select ☐ to remove the hidden status.

Note: The retired report themes Dark, Light, and Snow are hidden by default.

### Exporting and Importing a SAS Theme

The export function enables you to export a theme from SAS Theme Designer to a specific folder. It might be necessary to export a theme for administrative tasks or to work on a different SAS Theme Designer 3.3 installation. Users can choose to export or import themes in order to share a theme with other administrators, or they can promote themes from one SAS Viya installation to another.

To export a theme select the check-box for the theme and click ☑. The selected theme is automatically exported in a single file to a specified folder on your file system. The export file is labeled as ThemeDesignerExport.td.

You can export multiple themes by selecting the check-box for each theme before selecting ☑. The themes are then saved in a single, exported file.
To import a theme, click **Import** from the SAS Theme Designer window. A web browser file selection window appears. Select the exported theme file that you want to import and click **Open**. Any themes that are defined in the exported theme file are imported and listed on the Theme table.

For SAS Theme Designer 3.3, you can import either of the following file types:

- a ThemeDesignerExportxx.tdf file that is exported from SAS Theme Designer 4.7.3 for Flex.
- a ThemeDesignerExportxx.td file that is exported from SAS theme Designer 3.0 or later.

If a theme with the same name is already listed in SAS Theme Designer, you are prompted to replace that theme with the imported theme:

![Theme exists](image)

Click **Yes** to replace the existing theme or click **No** to create a new theme with an appended name. Depending on your selection, SAS Theme Designer makes the following updates:

- If you click **Yes**, the existing theme is overwritten. If the existing theme is published, its status is changed to draft.
- If you click **No**, SAS Theme Designer imports the new theme and automatically appends the imported theme name with a numeric value. For example, if a theme named Marketing Analysis exists and you try to import a theme that has the same name, clicking **No** automatically creates a theme named Marketing Analysis 1. A message is displayed indicating what has been done.

**Important:** SAS theme files are imported from the browser file system, not from the SAS folder structure where SAS reports are stored.

---

**Publishing Themes**

When creating and editing a SAS theme, you can keep the theme in a draft mode in order to reduce the impact of any changes on users. When you are ready for users to access the theme, you can publish the theme. You can change a theme from a draft state to a publish state at any time.

The **Publish** function enables you to publish a theme so that other SAS Viya applications can access the theme. Select a theme and click ➕.

The theme is now published and is available to SAS Viya applications. If you want to unpublish a theme, select a published theme and click ➖. The theme is now unpublished.
Note: The themes provided by SAS cannot be unpublished. They include Illuminate, Inspire, Aqua, Marine, Midnight, Opal, and High Contrast.

Setting a Default Theme

When SAS Theme Designer is initially installed, Illuminate is the default application theme and Marine is the default report theme. A SAS Theme Designer user can set a different theme as the default application theme or default report theme. A theme must be published before you can set it as a default theme.

On the Theme table, select a theme that is listed as Published. Click Yes. Click Yes. The selected theme is now the default theme. Any user who is assigned the default theme sees the new default theme when they next log on to the system. If they are logged in when the change occurs, the new theme takes effect when they switch applications or refresh the browser.

When a theme is set as the default application theme, and it is deleted, the Illuminate theme is reset as the default application theme. When a theme is set as the default report theme, and it is deleted, the Marine theme is reset as the default report theme.

The following themes provided by SAS cannot be deleted or edited: Illuminate, Inspire, Aqua, Marine, Midnight, Opal, and High Contrast.

Theme Designer Settings

You can access various options in the current session from the Application Options menu. To access the Application Options menu, click on the current user icon in the upper right corner of the SAS Theme Designer window. In the Application Options menu, select Settings.

The Settings pane enables you to change Global user settings that apply across applications. Within the Global settings, you can modify General settings, Region and Language settings, and Accessibility settings. Here is the Settings pane.
• The **General** menu contains settings for basic changes to your user environment. You can also display messages that have been closed by selecting **Reset Messages**.

• **Region and Language** menu contains settings for the locale that is used for sorting data and formatting values and the locale that is used for offline jobs or background processes.

• The **Accessibility** menu contains settings for accessibility changes to your user environment. For detailed information about these settings, see *SAS Viya Web Applications: General Usage Help*.

Click **Reset** to change values back to the original settings. **Reset** changes the settings for the menu that you are currently in.

*Note:* Click **Reset Messages** on the **General** menu to specifically change message settings. **Reset** does not apply to this function.

---

**SAS Help Center**

You can access the *SAS Theme Designer 3.3 User’s Guide* while in SAS Theme Designer by opening the Help Center. To access the Help Center, click on the current user icon in the upper right corner of the SAS Theme Designer window. The **Application Options** menu is displayed. From here you can select **Help Center**. The *SAS Theme Designer 3.3 User’s Guide* is available from the Help Center in HTML format and PDF.

*Note:* Pop-up blockers for your browser should be disabled in order to display the Help Center.

---

**Assigning Users to Custom Groups**

Creating themes is a highly specialized and infrequent task that should be performed only by an experienced administrator or designated visual designer. Access to SAS Theme Designer 3.3 is determined by membership in a custom group.

In order to access SAS Theme Designer 3.3, you must be included in the **Application Administrators** group. Membership in the **Application Administrators** group enables you to access and modify themes with SAS Theme Designer 3.3.

For further information about assigning users to the **Application Administrators** group, see “Predefined Custom Groups” in *SAS Viya Administration: Identity Management*. 
Chapter 4
Examples

Creating an Application Theme

Creating a Report Theme

Editing a Theme in Context

Creating an Application Theme

The SAS Theme Designer window shows existing application and report themes. It enables you to work with existing SAS themes and create new SAS themes. The following example steps through creating a new application theme and then modifying its colors and graphics:

1. On the SAS Theme Designer window, select New.

A menu of available themes opens. For this example, select Application Theme based on Illuminate.
2. A New Application Theme window appears. The application theme based on Illuminate is used. You can now make changes to the new theme.

3. You can change the primary color. Select the **Primary** color swatch. A color palette opens. The **Basic** tab displays a listing of **Standard colors** to choose from. Change the primary color to green.
The banner in the Preview pane is updated with the new color.

4. You can also change the logo for the banner in the Preview pane. On the Interface Styles pane, select Overrides. Select Banner.

Select a new Text color. In this example, the text color is changed to black. For the logo, drag a graphic file to the Logo field or browse the file system and add a graphic file.

The banner in the Preview pane is updated with the new black text color and the new logo graphic.
5. From the **Overrides** tab, you can switch between the **Initial Loading Screen** and the **Transition Screen** settings. You can change the colors of the page background and animation for either.

![Overrides tab screenshot]

After you have made changes on the **Overrides** tab, the **Animations** tab on the **Preview** pane is updated with the new colors for the initial loading screen.

![Preview pane screenshot]

6. You can also add a graphic file or an animated graphic file to the initial loading screen or transition screen. On the **Loading animation** option, select **Upload custom animation**. Select a graphic file or an animated graphic file from the file system. The graphic file is displayed in the **Image or animation** field.
The Animations tab on the Preview pane is updated with the selected graphic file.

For a SAS application theme, you can also update color swatches for graphs in an application theme. In the Graph Styles pane, you can edit the colors that are displayed in the Preview pane. You can select new color swatches or rearrange existing color swatches.

The following example steps through how to modify color swatches for graphs in an application theme:

1. The screen below shows that the last color swatch in the Data palette has changed from brown to red. The bar chart in the Preview pane is updated.
2. On Global Data Colors, click $\text{Edit}$. The Data palette is now in edit mode.

You can now rearrange color swatches on the Data palette. Select a color swatch and move it to the location in the Data palette that you want.

In the example below, the red color swatch has been moved to the first color in the Data palette.

The Solid Data Colors bar chart and line chart in the Preview pane are updated to reflect the new color order. The red color is now the first color in the graph.
While editing an application theme, you can also rename the theme by selecting the default theme name and entering a new name. In this example, the theme name is changed to *Marketing Theme*.

After you have finished modifying the theme, you can save the theme as a draft. You can also save and publish the theme by selecting the appropriate action in the *Save* menu.

Click ![generate](image). Your new theme is now listed in the table of available themes. You can now use it with other SAS Viya products that consume SAS themes. A theme must be published in order for all users to access it with other SAS Viya applications.

---

**Creating a Report Theme**

With SAS Theme Designer, you can create report themes for use with SAS Visual Analytics 8.4 reports. A report theme contains settings that control the color selections for different elements of a report such as tables, graphs, maps, and controls. The SAS Theme Designer window shows existing application and report themes.
The following example steps through how to create a new report theme and then modify its colors and graphics:

1. In the SAS Theme Designer window, click **New**. A menu of available base report themes opens. For this example, select **Report Theme based on Marine**.

2. A **New Report Theme** window appears. The default report theme is Marine. Now, select a report to preview changes. From the **Preview** pane, you can click **Choose Report**.

3. A file selection window appears. Locate and select a report. In this example, the report **Retail operations report** is selected. Click **Open**.
4. Once a report is loaded, you can make changes to different elements for the report theme. Select the first color (blue) in the **Data palette**.

5. A color palette opens. On the **Basic** color palette, select the color purple.
The color is updated to purple in the **Data palette** and on the **Preview** pane.

---

6. You can also rearrange existing colors on the Data palette. On the **Data palette** click 🎨. The Data palette is now in edit mode.
You can now rearrange colors on the Data palette.

Below, the green color swatch has been moved to the first color in the Data palette.

The graph colors on the Preview pane are updated to reflect the new color order.

You can also change the display size of individual graphs in the preview pane.

1. Position the pointer over the upper right corner of a graph or table to see the options.
   For graphs click √.
The graph is enlarged to fill the Preview pane.

2. You can then click \(\text{Restore}\) to restore the graph to the original display size as needed.

Each graph or table item on the Preview pane has a menu of action items. The menu options that are available for an item on the Preview pane is determined by the items that are included in the report. There are different menu items for tables or graphs, and map data. You can right-click over a graph or table and select Sort to drill into sort options for that graph or table.
You can scroll between tabs in the Preview pane by selecting the List of tabs.

You can also view data tips for a graph by positioning your pointer over the graph.

You can rename the theme by selecting the default theme name and entering a new name. In this example, the theme name is changed to Retail Report.
After you have finished modifying the report theme, you can save the theme as a draft. You can also save and publish the theme by selecting the appropriate action in the Save menu.

Click ![Image](image-url). Your new theme is now listed in the table of available themes. You can now use it with other SAS Viya products that consume SAS themes. A theme must be published in order for all users to access it with other SAS Viya applications.

---

### Editing a Theme in Context

Editing a theme in context enables you to preview changes to SAS application themes while accessing other SAS Viya products. In this example, create or open an application theme.

Click **Edit in Context** in the New Application Theme window.
The Edit in Context pane opens.

In this example, select **SAS Drive** as the SAS Viya application to switch to.
Click **Edit in Context**.

You are now switched to SAS Drive and the Edit Theme pane opens.

You can now edit interface styles or graph styles for the application theme. In this example, select **Interface Styles**.
In the **Interface Styles** pane, select the **Primary** color swatch. A color palette opens. On the **Basic** palette, change the primary color to green.

The primary color is updated and the SAS Drive window banner is changed to green.
You can also edit graph styles from the Edit Theme pane. Return to the initial Edit Theme pane and select Graph Styles.

The Edit Theme menu bar also enables you to undo or redo a change.

Click \( \text{undo} \) to undo an action or \( \text{redo} \) to redo an action as needed.

From the menu bar you can open the Edit Theme menu by selecting \( \text{Edit Theme} \).
From the **Edit Theme** menu, you can select from multiple save options.

You can also edit the theme in another SAS Viya application by selecting **Change edit context**. In this example, SAS Visual Analytics is selected. The **Edit Theme** pane opens in SAS Visual Analytics. The **Interface Style** color changes are applied to the SAS Visual Analytics window banner.

When you are finished making changes to the application theme, you can return to SAS Theme Designer by selecting **Edit in SAS Theme Designer** from the **Edit Theme** menu.
Chapter 5

TroubleShooting SAS Theme Designer

Troubleshooting Mozilla Firefox Time Threshold

When you are working in SAS Theme Designer 3.3 on the Mozilla Firefox web browser, it is possible to encounter a warning dialog box when using Edit In Context. When you click Continue on the Edit in Context pane, the Mozilla Firefox web browser might display an unresponsive script message.

Mozilla Firefox displays this warning message when the task that you are attempting to perform takes longer than the predefined time limit for that task. You can increase the time threshold for the Mozilla Firefox web browser by increasing a run-time preference value for Mozilla Firefox.

In the Mozilla Firefox web browser, go to this URL: https://support.mozilla.org/en-US/kb/warning-unresponsive-script. The instructions for changing the browser run-time preference are listed under the topic Letting the script run longer. You need to modify the Mozilla Firefox preference setting for dom.max_script_run_time.
Recommended Reading

Here is a list of recommended SAS documentation:

- *SAS Visual Analytics: Viewing Reports*
- *SAS Visual Analytics: Overview*
- *SAS Visual Analytics: Reference*
- *SAS Visual Analytics: Working with Report Content*
- *SAS Visual Analytics: Working with Report Data*
- *SAS Viya Administration: Identity Management*

For a complete list of SAS publications, go to sas.com/store/books. If you have questions about which titles you need, please contact a SAS Representative:

SAS Books
SAS Campus Drive
Cary, NC 27513-2414
Phone: 1-800-727-0025
Fax: 1-919-677-4444
Email: sasbook@sas.com
Web address: sas.com/store/books
Glossary

**application theme**

A group of customizable specifications that enables a user to apply a consistent look and feel across multiple applications. Elements of the user interface that are affected can include messages, tables, and graphs.

**report theme**

A group of customizable visual specifications that apply a consistent look and feel to SAS report content. A report theme controls style selections for different elements of a report, such as tables, controls, and graphs.
Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.